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Learning SAAM II Getting Started with Compartmental 

 
Getting Started with SAAM II Compartmental 

 
Prerequisites 
 

This tutorial has no prerequisites. It assumes you know the basics of the Windows 
operating system. It also assumes you have SAAM II’s Compartmental application 
installed on your computer, and that you know how to open the application. 

 
What you will learn in this tutorial 
 
The basic operations of the SAAM II Compartmental application: 
 

• How to use a SAAM II Compartmental study file. 
• How to use SAAM II Compartmental computational features. 
• How to view solutions. 
• How to build a model using the model building tools. 
• How to create an experiment on the model using the experiment tools. 
• How to enter data, and associate data with samples 
• How to enter your model parameters. 

 
Files Required 
 

Study Files: The study file for the Compartmental application is 
 

study_0.stu 
 

This file is included as part of this tutorial. This file is the same as study_0.stu 
that is installed in the SAAM II program folder, and referred to in the SAAM II 
User Guide. 
 

Data File: The data file for this tutorial is 
 

study_0.dat 
 
The data file is a text file. (This file is the same as study_0.dat that is installed in 
the SAAM II program folder, and referred to in the SAAM II User Guide.) 

 
Introduction 
 
This tutorial will show you how to perform the basic operations in the SAAM II 
Compartmental application. It is intended to help the new user get started quickly with SAAM 
II.  
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This tutorial is divided into two parts. In the first part, you will load an existing SAAM II file. 
The purpose is to familiarize you with the basic computational operations, and how to view 
information from solutions. In the second part, you will build a model. This will familiarize you 
with the tools used to build models and create experiments. 
 

 In this SAAM II tutorial, special information or notes to assist the user in using the 
Compartmental application are preceded by the Compartmental symbol on the left 
and end with the small Compartmental symbol. 

 
 
Part 1.  Using a Compartmental Study File 
 
This part of the tutorial will show the key components of the model of a system and an 
experiment on the system, and the fundamental operations of SAAM II - solving, fitting, and 
viewing solution. You will work with the following two-compartment model.  
 

 

 

 Transfer coefficients. The SAAM II convention for the transfer coefficients k(i,j) is 
k(to,from). Thus k(2,1) is the transfer rate to Compartment 2 from Compartment 1. 
The transfer rate k(0,1) is the rate of irreversible loss from Compartment 1. The input 
arrow U(1) is for system experiments in tracer-tracee experiments; this will not be 
discussed in the tutorial. 

 
 

1. Start the SAAM II Compartmental application. 
 
2. Open the SAAM II Compartmental study file study_0.stu. 

 
The file study_0.stu should appear in the file list; if it does not, find the folder where you 
put this file. 
 
In the File menu, click Open. 
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The SAAM II Compartmental main window will open as shown below: 
 

 
 
The model shown on the Drawing Canvas is the SAAM II Compartmental 
representation of a two-compartment model. In SAAM II terminology, it is called the 
System Model; it is a mathematical representation of how the system functions, and is 
normally used to interpret tracee data in a tracer-tracee experiment. The input arrow U(1) 
represents tracee input in a tracer-tracee experiment and will not be discussed in this 
tutorial. 
 
The SAAM II Compartmental main window consists of four main areas: 
 

The Menu bar: 
 

 
 
This menu bar contains the SAAM II menu items. 

 
Below the Menu bar is the SAAM II Toolbar: 
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This toolbar contains SAAM II specific tools such as “Solve” or “Fit.” Most of 
the toolbar functions can be found in the Show and Compute menus. 

 
The Drawing Canvas will appear in part as follows: 

 

 
 

The Drawing Canvas contains the area for building models and creating experiments. 
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The SAAM II Toolbox: 
 

 
 
The SAAM II Toolbox will be discussed in detail in the next part of this tutorial. 
 
Take a minute to examine the various tools on the SAAM II Toolbar and in the 
Toolbox. Place the cursor on top of a SAAM II tool to show text describing the tool’s 
function. 
 

3. As you proceed through this tutorial, you will notice that several windows can be open at 
one time; this is normal and as you will see can be very helpful. An example is shown as 
follows: 
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In most cases in this tutorial, only the current window will be shown in the text. In the 
actual application, several windows may actually be open. 

 
4. Dialog boxes associated with SAAM II objects. 

 

  Objects and dialog boxes. Every object on the Drawing Canvas has a dialog box 
associated with it. 

 
 
a. To open the dialog box associated with a particular object, simply double-click that 

object. For example, if you double-click Compartment 1, the Compartment 
Attributes dialog box for Compartment 1 will open as shown below: 
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There is a box with the compartment number in it, and a box to add a reference name. 
If you wish, you can change the compartment number, or you can add a reference 
name such as “Plasma.” The reference name will appear in the circle that represents 
Compartment 1; it is for reference purposes only and is not used by the software. 
 

b. To close the dialog box, click Done.  
 

5. Open and investigate the experiment on the System Model. 
 

 Models of systems and models of experiments: It is very important to understand the 
SAAM II philosophy of separating the creation of the system model, i.e. how you 
believe your system functions in terms of a compartmental model, from duplicating 
an actual laboratory experiment on the model. As you will learn in Part 2, the Model 
tools in the SAAM II Toolbox allow you to build a model for the system, and the 
Experiment tools in the SAAM II Toolbox allow you to create an experiment on the 
system model. 

 
 

a. In the SAAM II Toolbox, click Experiment. The SAAM II Compartmental main 
window should appear as follows: 
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This is the model of the experiment. Notice that the compartment names have 
changed from 1 and 2, to q1 and q2. In SAAM II, q1 and q2 represent the differential 
equations created internally and solved by SAAM II. The input arrow U(1) is now 
replaced by the experimental input syringe, ex1, and there is a sample icon, s1, 
representing the experiment sample. The input arrow U(1) represents tracee input in a 
tracer-tracee experiment and will not be discussed in this tutorial. 

 
b. On the Drawing Canvas, double-click ex1. The Exogenous Input dialog box will 

appear as follows: 
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  Experiment inputs. There are many useful options for experiment inputs that you can 
specify in this dialog box. Several different types of input are possible: bolus, 
infusion, primed infusion, equation-described, repeated inputs, and split inputs. For 
this tutorial, a single bolus injection of 1.04e+08 dpm (disintegrations per minute) is 
being used. 

 
 
c. To close the dialog box, click Done.  
 
d. On the Drawing Canvas, double-click s1. The Sample Attributes dialog box will 

open as follows: 
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  Sample Attributes. There are many useful options for the experimental sample that 
you can specify in this dialog box. 

 
The units of the experimental data, in this case dpm/ml, are for reference purposes 
only.  

 
The Associate with Data Name box contains the name of the data in the data file 
associated with this sample. If you do not have a data name associated with a sample, 
and try to fit the model to the data, SAAM II will generate a warning message. 

 
The sample equation in the Equations pane, in this case "s1=q1/vol”, is the equation 
which links the solution of the differential equation q1 with the data. Writing the 
sample equation is a fundamental step in building a model and adds a new parameter, 
vol, to the model. 

 
 

 
e. To close the dialog box, click Done. 

 
6.  View the data. 

 
Data in SAAM II are entered in a text file where columns are space delimited. The data 
file for the study study_0.stu can be viewed as follows: 
 
a. In the Show menu, click Data, or alternatively, on the SAAM II Toolbar click Data 

. The Data window will open as follows: 
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The first line of the data file is the word “DATA.” The next line, (FSD 0.1) specifies 
the weights assigned to the data. The first column in the data file is always the 
independent variable, usually time denoted t. The columns representing data can be 
named whatever you wish; the name is case sensitive. However, the name of this 
column must be the same as the name in the appropriate Sample Attributes dialog 
box. 
 

  Data weighting. Data weighting is used to provide a measurement of the user’s 
confidence in a particular datum and is used in the “fitting” process. Data weights are 
calculated as the inverse of the data variance. SAAM II contains several variance 
models. If no method is explicitly specified, a fractional standard deviation of 0.1 
(FSD 0.1) is assigned as the variance model to each datum. 

 
 SAAM II calculates weight for each datum from the standard deviations you assign 

to your data. In the file above, the variance model, (FSD 0.1), means that a constant 
coefficient of variation (fractional standard deviation) of 10% is assigned to each 
datum. Therefore, for example, the standard deviation of the datum of 46780 is 4678. 

 
 

b. Close the Data window. 
 

5. View the model parameters. 
 
The model has four parameters: k(2,1), k(1,2), k(0,1) and vol. These parameters are 
entered in the Parameters dialog box. 
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a. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar 

click Parameters . The Parameters dialog box will open as shown below: 
 

 
 

  Properties of parameters. There are several important features of the Parameters 
dialog box. 

 
i. Each parameter has a "Type" that is either “fixed” or “adjustable.” A fixed 

parameter is a parameter that is assumed to be known and does not change when 
the model is “fitted” to the data. An adjustable parameter is adjusted when model 
is “fitted” to the data. 

 
ii. Each parameter, whether fixed or adjustable, has a "current" value; this is the 

value that will be used when you Solve or Fit the model. 
 
iii. Adjustable parameters have upper and lower limits. These are limits that cannot 

be exceeded when SAAM II Fits the model to the data. If SAAM II is Fitting the 
model to the data and a limit is reached, SAAM II will display a warning 
message. 
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iv. To change a parameter value, double-click on the parameter name. Its current 

value, and high and low limits if it is adjustable, will be shown in the Value, High 
Limit and Low Limit boxes respectively. To save the changes, click Save. 

 
 

b. To close the Parameters dialog box, click Done. 
 

6. Solve the model. 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II Toolbar 

click Solve . 
 

 Solve. When you “Solve,” SAAM II uses the current values of the parameters to 
solve the system of differential equations represented by the compartmental model. 

 
 During a “Solve,” a Solve Status message will appear showing the status of the 

integration (solving). For small models such as this one, the message will appear and 
disappear extremely fast. For larger models, you can watch the progress. You can also 
choose to abort a “Solve.” 

 
 

7. View the solution to the model using Quick Plot. 
 

a. On the Drawing Canvas, click s1 to select it. 
 
b. In the View menu, click Quick Plot. 

 
The following plot will appear in the Quick Plot window. Notice that the scale is linear.  
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  Quick Plot. Quick Plot has preset defaults that you cannot change. As you can see 
below, when you use the Plot command, you have more flexibility in what you can 
plot and how you can plot it. 

 
 
c. To view this plot in semi-logarithmic mode, in the View menu, click Semilog. The 

plot will appear as follows: 
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d. Close the Quick Plot window. 
 

8. View the solution to the model using the Plot command. 
 

a. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar click Plot 

. The Plot and Table Variables dialog box will open as follows: 
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Only the variables that are associated with data will appear in the Variables for Y-Axis 
pane. However, you can plot any of the variables in the model as described below. 
 
b. In the Plot and Table Variables dialog box, select the List All Variables check box. 

All the variables that can be plotted will appear as follows: 
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You can now select among the different variables for the Y-Axis for the plot. 
 
c. In the Plot and Tables dialog box, clear the List All Variables check box to clear the 

Y-Axis variables except s1:plasma. 
 
d. In the Variables for Y-axis pane, click s1:plasma. The selection will move to the 

Current Selection pane. 
 
e. Click Done. 

 
A plot similar to the previous Quick Plot will appear. 

 
9. Change the plot variables. 

 
SAAM II will remember the plot variables, e.g. s1:plasma when you open and shut the 
Plot window. If you want to change the plot variables, you need to change the variable 
names using the Plot and Table Variables dialog box in the Set menu while a Plot 
window is open. The following will illustrate how to plot q1 and q2 so you can compare 
the model solution for these two variables. 

 
a. With the Plot window open, in the Set menu, click Plot/Table Variables. The Plot 

and Table Variables dialog box will open. 
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b. Select the List All Variables check box (notice s1 and plasma are selected). 
 

c. In the Variable for Y-Axis pane, click q1; q1 moves to the Current Selection pane. 
 
d. Press the CTRL key and click q2; q2 moves to the Current Selection pane. 

(Pressing the CTRL key allows you to select multiple items). The Plot and Table 
Variables dialog box will appear as shown below: 

 

 
 

e. Click Done. The plot will appear as follows: 
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f. With the Plot window open, in the Set menu click Plot/Table Variables. The Plot 
and Table Variables dialog box will open. Clear the List All Variables check box. 
In the Variables for Y axis pane, click s1:plasma, then click Done. The Plot 
window will appear as follows: 
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10. Fit the model to the data. 
 

a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar click Fit 

. 
 

  Leaving the Plot window open. The Plot window can remain open during a “Solve” 
or “Fit.”. The plot will be updated after a successful “Solve” or “Fit.” 

 
 
 

  Fit status. During a “Fit,” a Fit Status message will appear (on a fast computer, you 
may just see a flash). This is the counterpart to the Solution Status message you saw 
when you solved the model originally. The Fitting Status bar gives information both 
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on the integration part of the “Fitting” and on the number of iterations. You can abort 
the “Fit” by clicking Abort. 

 
 
When you have Fitted the model to the data, the SAAM II Compartmental main 
window should appear with the Plot window as follows: 
 

 
 

The new parameter values will replace the original estimates in the Parameters dialog 
box, and the best fit of the model to the data appears in the plot. (You can change the plot 
to semi-logarithmic if you wish by clicking Semilog in the View menu - this is possible 
because the Plot window is open.) The semilog plot will appear as follows: 
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11. View the statistics associated with the “Fit.” 
 

a. In the Show menu, click Statistics, or alternatively on the SAAM II Toolbar click 

Statistics . The Statistics window will appear as follows: 
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  Statistical information following a successful “Fit.” The Statistics window contains 
information about the “Fit.” It includes 

 
i. the final values for the parameters, their estimated standard deviation, percent 

coefficient of variation, and 95% confidence interval. 
ii. the following objective function information: 

• Final value of the objective function (this is the function that is minimized 
during the fitting process) 

• Scaled data variance (this is a number that is estimated during the fitting 
process when you use relative weighting – the default option in SAAM II) 

• Values for AIC and BIC; these values are used in the model development 
process to help assess which model structure best fits the data. 

iii. the Covariance matrix. 
iv. the Correlation matrix. 

 
If, for example, in the Statistics window, you select the Correlation Matrix option, the 
Correlation Matrix will appear in the lower half of the Statistics window. The 
Covariance Matrix or the values for the Objective will appear if you select one of these 
other options. 

 
 

b. Close the Statistics window. 
 
c. Close the Plot window. 
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12. Quit the SAAM II Compartmental application 

 
a. In the File menu, click Exit. 
 
b. Click No (you do not wish to save the file). 
 
 

Part 2.  Building models and creating experiments in the SAAM II Compartmental 
application. 

 
This part of the tutorial will show you how to build the two-compartment model and conduct the 
experiment on the model used in Part 1. This part of the tutorial will show you how to use the 
Model and Experiment tools in the SAAM II Toolbox for building system models and creating 
experiments on the models. 

 
1. Start the Compartmental application. The SAAM II Compartmental main window 

will open as follows:  
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2. Create the two compartments of the two-compartment model. 
 

a. In the SAAM II Toolbox, click Model. (This ensures that the SAAM II Model 
building tools are available.) 

 
b. In the SAAM II Toolbox, click Compartment (this tool is now available).  
 
c. Click on the Drawing Canvas approximately where you would like the first 

compartment to be located. A compartment with the number 1 will appear on the 
Drawing Canvas. 

 
d. Click Compartment in the SAAM II Toolbox a second time (this tool is again 

available). 
e. Click on the Drawing Canvas approximately where you would like the second 

compartment to be located. A compartment with the number 2 will appear on the 
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Drawing Canvas. The SAAM II Compartmental main window should appear 
as shown below: 

 

 
 

 Locking Tools. If you know you are going to be creating several compartments for the 
model, you can lock the Compartment tool so it is available until you unlock it. For 
example, to facilitate building a multi-compartmental model, you can do either of the 
following: 

 
i. In the SAAM II Toolbox, double-click Compartment to lock the tool, or 
 
ii. In the SAAM II Toolbox, click Compartment, and then select the Lock check 

box at the bottom of the SAAM II Toolbox. 
 
The Compartment tool will be available until you unlock it by clicking Select in the 
SAAM II Toolbox. 

 
 

  Objects and Dialog Boxes. Remember, every object on the SAAM II 
Compartmental Drawing Canvas has a dialog box associated with it. Double-click 
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compartment 1 to open the Compartment Attributes dialog box associated with this 
compartment. Type “Plasma” in the Reference Name box as shown below: 

 

 
 

Click close the dialog box, click Done. Note the word “Plasma” appears in the circle 
that represents Compartment 1. 

 
 

3. Construct transfers between Compartments 1 and 2. 
 

a. In the SAAM II Toolbox, double-click Flux (notice that double-clicking will lock 
the Flux tool so you can perform multiple operations). 

 
b. On the Drawing Canvas, click on Compartment 1, and then click on Compartment 2. 

 
A flux (transfer) arrow to Compartment 2 from Compartment 1 that is labeled k(2,1) 
is created. If the label does not appear, it is because Compartments 1 and 2 are too 
close to each other. If this is the case, move Compartment 2 farther away from 
Compartment 1. 

 
c. On the Drawing Canvas, click on Compartment 2, and then click on Compartment 1. 
 

A flux (transfer) arrow to Compartment 1 from Compartment 2 that is labeled k(1,2) 
is created. 

 
d. In the SAAM II Toolbox, click Select. The Flux tool is no longer available. 
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The SAAM II Compartmental main window should appear as shown below: 
 

 
 
Notice, as described above, Compartment 1 has been given the reference name “Plasma.” 
 

 Creating transfers. To create a transfer between, for example, Compartment 1 and 2, 
with the Flux tool available, you can click on Compartment 1 and drag to 
Compartment 2. 

 
 

4. Construct losses from Compartments 1 and 2. 
 

a. In the SAAM II Toolbox, double-click Flux. 
 
b. On the Drawing Canvas, click on Compartment 1, and then click anywhere on the 

canvas. 
 

This will create a loss, k(0,1), from Compartment 1. No matter where you click on the 
Drawing Canvas, the loss will always point down. 
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c. On the Drawing Canvas, click on Compartment 2, and then click anywhere on the 
canvas. 

 
This will create a loss, k(0,2), from Compartment 2. 

 
d. In the SAAM II Toolbox, click Select. The Flux tool is no longer available. 
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The SAAM II Compartmental main window should appear as follows: 
 

 
 

 Moving or nudging a compartment on the Drawing Canvas. Suppose after you have 
created the model you want to move or nudge a compartment on the Drawing 
Canvas to line it up with another object. To move an object, click the compartment or 
delay you wish to move, and drag the object to where you would like it to be located 
on the Drawing Canvas. To nudge an object (e.g. to straighten transfer arrows), click 
the compartment you wish to nudge, and nudge it using the directional arrows on the 
keyboard. 

 
 

  Correcting a mistake by deleting an object. Suppose you accidentally add an object to 
the model by mistake. To delete the object from the Drawing Canvas: 

 
i. On the Drawing Canvas, click the object you wish to delete. 

 
ii. Either press the Delete key, or in the Edit menu, click Delete. The following 

warning message will appear as follows: 
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iii. Click OK if it is okay, otherwise click Cancel. 

 
 

 Deleted Objects. When a compartment or delay is deleted, all attached arrows, 
experimental samples and inputs are also deleted! 

 
 

5. Delete the loss k(0,2) from the model. 
 

a. On the Drawing Canvas, click k(0,2) to select it. 
 
b. Press the Delete key. 
 
c. Click OK. 

 
This will delete the loss k(0,2) from the model. 
 

At this point, you have successfully created the two-compartment system model with a single 
loss from Compartment 1 used in Part 1. You now want to reproduce the experiment performed 
in the laboratory on this model. This point emphasizes the difference between building the 
system model and creating an experiment on the model. Obviously, as you can see below, there 
are many different experiments that can be created on the model. The main differences are where 
and how inputs are made, and where and how samples are taken. Separating the system from the 
experiment permits maximum flexibility in using the tools in the SAAM II Toolbox. 
 

6. Create the experiment. 
 

a. In the SAAM II Toolbox, click Experiment. Notice that the Model tools are 
unavailable and the Experiment tools are available.  

 
The Experiment Attributes dialog box will open as follows: 
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b. Change the entry in the Units box from “minutes” to “days.” 
 
c. Enter “9” in the End at box. The Experiment Attributes dialog box will appear as 

shown below: 
 

 
 
 

 Experiment Attributes. The Experiment Attributes dialog box is normally where 
you set the ending time of the experiment. Units are for convenience only. Start at is 
normally zero which is the time of the first test input. End at is normally the time at 
which the experiment ends. There are, however, occasions when you may wish to set 
End at to a larger value. 

 
 

d. Click Done. 
 

The Create Experiment dialog box will appear on the Drawing Canvas. The choice of 
experiment Types is an Experiment or a System. Experiment is selected. The New 
Name is “Exper” as shown in the following: 
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e. Click Create. 
 

  Experiment vs. System. The Create Experiment dialog box is where you create your 
experiment. There are two types of experiments - “Experiment” and “System”. 

 
The Experiment type will invoke SAAM II’s differential equation machinery. When 
you create this type of experiment, your compartmental model will be interpreted by 
SAAM II as a system of differential equations. Once parameter values and inputs 
have been specified, SAAM II can Solve the system of differential equations, and can 
Fit your model to your data. This type of experiment is designed to deal with time 
dependent data following an experimental (exogenous) input into the system.  

 
The System experiment creates a system of algebraic equations whose coefficients 
are the k(i,j) of your compartmental model. The System model is used primarily in 
tracer-tracee experiments to describe the tracee data in the steady-state. 

 
 The default New Name is “Exper”. This can be changed to a name of your choice. 

 
 
f. The SAAM II Compartmental main window should appear as follows: 
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 SAAM II Notation. Remember the model looks like the original model except now the 
compartment numbers have changed from 1 and 2 to q1 and q2. Here q1 and q2 
represent the solutions to the differential equations q1’ and q2’ created internally by 
SAAM II. The q1 and q2 are the calculated masses of experimental inputs into the 
two compartments at time t.  

 
 

To recreate your laboratory experiment on the model, you need to specify the site and amount of 
your experimental input, the site of your measurement, and specify the measurement equation. 
 

7. Add an experimental input to the model. 
 

a. In the SAAM II Toolbox, click Input. 
 
b. On the Drawing Canvas, click Compartment q1, and then click on the canvas. 

 
An input arrow named ex1 will appear on the Drawing Canvas pointing to Compartment 
q1. The SAAM II Compartmental main window should appear as follows: 
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c. Double-click ex1. The Exogenous Input dialog box will open.  
 
b. Enter “1.04e+08” in the Initial Amount box. 
 
e. Click Add. The Exogenous Input dialog box should appear as follows (this is 

identical to the Exogenous Input dialog box you viewed in Part 1): 
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f. Click Done. 

 
9. Create a sample on the model. This sample will represent the sample you collected in 

your actual experiment. 
 

a. In the SAAM II Toolbox, click Sample. 
 
b. On the Drawing Canvas, click Compartment q1, and then click on the canvas. 

 
A sample object, s1, will appear on the Drawing Canvas attached to Compartment q1. 
This means your sample was from plasma. Notice that the circle at the top of the sample 
object is an open circle. The sample object can be moved on the Drawing Canvas as 
described above. 
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The SAAM II Compartmental main window should appear as shown below: 

 

 
 

c. On the Drawing Canvas, double-click s1 to open the Sample Attributes dialog box 
as shown below: 

 

 
 
d. Type “plasma” in the Associate with Data Name box. As discussed in more detail 

below, “plasma” is the name of the data in the data file. 
 
e. Edit the sample equation “s1 = q1” to read “s1 = q1/vol” in the Equations pane. As 

discussed below, vol will become a new parameter in the model. 
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 The Sample Equation. The sample equation, in this case “s1 = q1/vol”, is what links 
the solution to the differential equations, the q1 and q2, with the data. The units of the 
differential equations are determined by the units of the input, ex1. The units of your 
data are usually concentration. Thus the sample equation keeps the units of the 
differential equations and the units of the data consistent. 

 
 

 
f. If you wish, you can type “dpm/ml” in the Units box; this will be for bookkeeping 

purposes only. 
 
The Sample Attributes dialog box will appear as shown below: 
 

 
 
g. Click Done. A warning message will appear because you have not entered your data 

yet. This warning message is shown below: 
 

 
 

h. Click OK. 
 

 Sample Attributes. There are a number of important points to be made here that will 
help you when you use the SAAM II Compartmental application: 
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i. When you close the Sample Attributes dialog box, you will get a warning 

message that the data element, i.e. the data named “plasma,” does not exist yet. 
This is because you have not yet entered your data. If you had entered the data 
first, and your data contained a column named “plasma,” you would not get this 
message. 

 
ii. The data name in SAAM II is case sensitive. Thus “Plasma” and “plasma” will be 

read as two different names. 
 
iii. The circle at the top of the Sample object will be solid when there is a data name 

associated with the sample. This is used as a modeling aid to help remind you 
when data associations were made. 

 
iv. The sample equation “s1 = q1/vol” introduced a new parameter vol for the volume 

of Compartment q1.  
 

 
10. Add the data to the SAAM II Compartmental model. 

 
The data you will use in study_0 are shown below. These are decaying data following the 
bolus injection of a radio-labeled protein. A plot of these data is shown below: 
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a. On the Show menu, click Data, or alternatively, on the SAAM II Toolbar, click 

Data . The Data window will open. 
 
b. On the File menu, click Open. The file study_0.dat should appear in the list (if it 

does not, find the folder where you put this data file). 
 
c. Double-click study_0. The data in this file will appear in the Data window. The 

model and the Data window should appear on the Drawing Canvas as follows: 
 

 
 

d. Close the Data window. 
 

  Error structure of the data. For this introductory tutorial, the errors in the data are 
assumed to be a constant coefficient of variation; in this case Fractional Standard 
Deviation (FSD); this is denoted in the data file by (FSD 0.1). 

 
 

11. Enter the parameter values. 
 
The parameters for the model are k(2,1), k(1,2), k(0,1) and vol. 
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a. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar 

click Parameters . The Parameters dialog box will open as follows: 
 

 
 

The parameter k(0,1) should be selected. If it is not selected, double-click k(0,1) to 
select it. Be sure the Adjustable button is selected. 
 

b. Enter "0.1" in the Value box, and click Save. 
 

  Default low and high parameter limits. Notice that when a value is entered in the 
Value box and nothing is entered in the Low Limit or High Limit boxes, the default 
low and high limits of one tenth of the value and ten times the value respectively are 
automatically entered when the value is saved. 

 
 
c. Double-click k(1,2) to select it. 
 
d. Enter "0.1" in the Value box, and click Save.  
 
e. Double-click k(2,1) to select it. 
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f. Enter "0.1" in the Value box, and click Save. 
 
g. Double-click vol to select it. 
 
h. Enter "2000" in the Value box, and click Save. 
 
When you have finished, the Parameters dialog box should appear as follows: 
 

 
 
i. Click Done. 

 

  Single or double-clicking a parameter in the Parameters dialog box. When the 
Parameters dialog box is open, there is always a current parameter. Its name appears 
in Name: in the lower pane. The Value, Low Limit and High Limit boxes will either 
contain the values associated with the current parameter or be empty if no values have 
been entered. 
 
If you single-click on another parameter, the Name of the current parameter will not 
change nor will the entries in the Value, Low Limit and High Limit boxes. 
However, if you click Save, the current Value, Low Limit and High Limit shown in 
the boxes will be saved for the new parameter. This makes it easy to enter the same 
values for more than one parameter. 
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If you double-click on another parameter, the name of the new parameter will appear 
in Name:. The Value, Low Limit and High Limit boxes will change to the values 
associated with this parameter. If no values were entered for this parameter, these 
boxes will be cleared, and you can enter the new values for this parameter. 

 
 
You have now successfully created the model used in Part 1 of the tutorial. 
 

12. Quit the SAAM II Compartmental application. 
 

a. In the File menu, click Exit. 
 
b. Click No.  
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Data for this tutorial 
 
DATA 
(FSD 0.1) 
t plasma 
0.007 46780 
0.042 43522 
0.125 42535 
0.25 40125 
0.375 36221 
0.5 35562 
1.0 28194 
2.0 19573 
3.0 14403 
4.0 11278 
5.0 8081 
6.0 6999 
7.0 5653 
8.0 5139 
9.0 4210 
END 
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